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About This Manual

This manual explains the basic procedures for using serial data trigger and decode software options for Teledyne
LeCroy oscilloscopes. There are also sections pertaining to the measure, graph and eye diagram capabilities of
TDME options. It is assumed that you have a basic understanding of the serial data physical layer specifications, and
how to use the oscilloscope on which the option is installed. Only features specific to this product are explained in
this manual.

While some images may not exactly match what is on your oscilloscope display—or may show an example taken
from another standard—be assured that the functionality is identical. Product-specific exceptions will be noted in the
text.

Some capabilities described may only be available with the latest version of our MAUI® software. Updates are
available from the software download page at teledynelecroy.com under Oscilloscope Downloads > Firmware
Upgrades.



https://teledynelecroy.com/

Introducing SENTbus TD and TDME

Introducing SENTbhus TD and TDME

The Teledyne LeCroy SENTbus TD and TDME options are tools aimed at decoding SENT (Single Edge Nibble
Transmission) and SENT SPC (Short PWM Code) streams emitted by various sensors. The decoder supports the
2008, 2010 and 2016 SENT specifications.

The SENTbus trigger and decode (-TD) option enables you to decode and filter SENT and SENT SPC serial data
streams by frame IDs, data patterns, CRCs, Master Trigger Pulse lengths, or protocol errors in . You can also trigger
acquisition upon the occurrence of selected SENT protocol errors; start of the next slow channel, fast channel or any
type of message; and IDs or data patterns within slow or fast channel messages. Conditional filtering at different
levels enables you to target the trigger to a single message or a range of matching data.

When displayed on oscilloscopes or in MAUI® Studio remote oscilloscope software, the decoded information
overlays the actual physical layer waveforms, color-coded to provide fast, intuitive understanding of the relationship
between message frames and other time-synchronous events.

Note: The current trigger implementation supports only SENT, not SENT SPC.

The SENTbus trigger, decode, measure/graph and eye diagram option (-TDME) adds a set of measurements
designed for serial data analysis and protocol-specific eye diagram tests to the standard trigger and decoder
capabilities. See Measuring for instructions on using the measure and graphing capabilities. See Eye Diagram Tests
for instructions on using the eye diagram tests.

Note: If you have installed other -DME or -TDME options, the dialogs for Measure/Graph and Eye Diagram
creation will appear when the decoder is open. They may or may not appear "grayed out." We do not
guarantee the correct operation of the functionality unless it is explicitly supported by the installation of a
TDME option for this protocol.
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Serial Trigger

"T" options provide advanced serial data triggering in addition to decoding. The serial data trigger scrutinizes the
data stream in real time to recognize "on-the-fly" the user-defined serial data conditions. When the desired pattern is
recognized, the oscilloscope takes an acquisition of all input signals as configured in the instrument's acquisition
settings. This allows decode and analysis of the signal being triggered on, as well as concomitant data streams and
analog signals.

Note: The trigger and decode systems are independent, although they are seamlessly coordinated in the
user interface and the architecture. It is therefore possible to use the serial trigger without displaying the
decoded acquisition, or to decode acquisitions made without using the serial trigger.

Requirements

Serial trigger options require the appropriate hardware (please consult support), an installed option key, and the
latest firmware release. See Serial Trigger Inputs for supported input channels and devices.

Restrictions

The serial trigger operates on only one protocol at a time. It is therefore impossible to express a condition such as
"trigger on CAN frames with ID = 0x456 followed by LIN packet with Adress OxEBC."

Low-speed serial trigger is not supported on LabMaster series models, only decode, measure and eye diagrams.
Some low-speed serial triggers are not supported on WaveMaster models. See the Serial TDME Datasheet for
support by option.

Serial Trigger Inputs

Digital

SENT Any channel or Ext In Any group or line, using digital leadset with
built-in MSO only. HDA125 and external
MS250/MS500 are not supported.
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Serial Trigger

SENT Trigger Set Up

To access the serial trigger dialogs:

» Touch the Trigger descriptor box or choose Trigger > Trigger Setup from the Menu Bar.
» Touch the Serial Type button, and the SENT Standard button.

Then, working from left to right, make the desired selections from the SENT dialog.

Source Setup
In SRC 1 (Data), select the data source input channel.

Use the Threshold control to adjust the vertical level for the trigger.

Physical Layer and Protocol Settings
Enter the Tick Time of the input signal.

Enter a Tick Time Tolerance (in percent). This defines how the CAL pulse is filtered with respect to the Tick Time. For
example, if a Tick Time of 3 us is set with a tolerance of 10%, the CAL pulse is expected to be 56 * 3 us + 10%,
therefore 168 ps + 10%.

Enter the number of Nibbles in one Word (default is 8).
Check Pause Pulse if using a Pause Pulse as per the 2010 specification, section 5.2.6.
Check New CRC if performing CRC computation as per the recommendations of the 2010 specification, section

5.4.2.2. Otherwise, the trigger will follow the guidelines of the 2008 specification, section 5.4.2.7 (Legacy).

Trigger Type

Choose the type of event on which to trigger:
» Start of the selected message type.
» Slow Channel Message or Fast Channel Message data pattern. Enter the pattern as shown below.

» Protocol Error.

Start Trigger

Choose to trigger on the Start of Any Message, the next Slow Channel Message or the next Fast Channel Message.

SENT TriggerScan
Trigger Type
Slow Any

Start Channel
Message

Slow Channel Message

Fast Channel B
Message Fast Channel Message

205.0 mV/
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Slow/Fast Channel Trigger

First choose to enter and display values in Binary or Hex(adecimal) format. The selection propagates throughout the
entire trigger setup. Toggling between formats does not result in loss of information, but will transform the
appearance of values.

For Fast Channel Messages, enter the Status Nibble value.

For Slow Channel Messages, choose whether to test Short Serial Message(s) or Enhanced Serial Message(s) of 4 or
8 Bits, then enter the frame ID value.

Use Data Condition (Boolean operator) and Data Value together to specify the data pattern upon which to trigger.
The pattern is assumed to begin at the 0 (i.e,, first) data byte in the message. If this is not desired, then add
preceding or trailing wildcard (X) nibbles to the pattern.

To specify a range of values that may fire the trigger, choose In Range or Out Range. When setting a range, enter the
start value in Data Value and the stop value in Data Value To.

Note: When more than one data byte is entered, the data is treated as Most Significant Byte (MSB) First. In
Hexadecimal format, data must be entered as full bytes even though the minimum acceptable entry is a
nibble. If less than a full byte is entered, wildcards (XX) precede the pattern values entered.

Use an At Position of Value (instead of the default "Don't Care") to mark a specific Nibble Pos(ition) in the Data field
the matching Data Value must occupy. You can select any position up to the maximum valid for that protocol,
starting with Byte 0 (the first data byte).

Nibble Length defaults to the length, in nibbles, of the pattern set in Data Value. If the length is changed to a lesser
value, the start of the Data Value is truncated by the number of bytes equal to the difference. If the length is
increased, wildcards (XX) equal to the difference are appended to the beginning of the value.

Q CLOSE|

Setup Format M jpe | 1D Setup
Data Gonditior
Slow Any 3 In Range of
Start Channel Binary 4 Bits
Message Short Serial
Fast Channel Hex Message
v Error Enhanced

Message Serial LE

7
205.0 mV

Error Trigger

The Error trigger fires whenever a protocol error of the selected type is found. Select all the error types you wish to
trigger upon.

SENT Trigge

Slow
Start Channel

Message

Fast Channel e
Message

205.0 mV
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Using the Decoder with the Trigger

A key feature of Teledyne LeCroy trigger and decode options is the integration of the decoder functionality with the
trigger. While you may not be interested in the decoded data per se, using the decoded waveform can help with
understanding and tuning the trigger.

Stop and Look

Decoding with repetitive triggers can be very dynamic. Stop the acquisition and use the decoder tools such as
Search, or oscilloscope tools such as TriggerScan, to inspect the waveform for events of interest. Touch and drag
the paused trace to show time pre- or post-trigger.

Optimize the Grid
The initial decoding may be very compressed and impossible to read. Try the following:

* Increase the height of the trace by decreasing the gain setting (V/Div) of the decoder source channel. This
causes the trace to occupy more of the available grid.

e Change your Display settings to turn off unnecessary grids. The Auto Grid feature automatically closes unused
grids. On many oscilloscopes, you can manually move traces to consolidate grids.

» Close setup dialogs.

Use Zoom

The default trigger point is at zero (center), marked by a small triangle of the same color as the input channel at the
bottom of the grid. Zoom small areas around the trigger point. The zoom will automatically expand to fit the width of
the screen on a new grid. This will help you to see that your trigger is occurring on the bits you specified.

If you drag a trace too far left or right of the trigger point, the message decoding may disappear from the grid. You
can prevent "losing" the decode by creating a zoom of whatever portion of the decode interests you. The zoom trace
will not disappear when dragged and will show much more detail.

Saving Trigger Data

The message decoding and the result table are dynamic and will continue to change as long as there are new trigger
events. As there may be many trigger events in long acquisitions or repetitive waveforms, it can be difficult (if not
impossible) to actually read the results on screen unless you stop the acquisition. You can preserve data concurrent
with the trigger by using the AutoSave feature.

» AutoSave Waveform creates a .trc file that copies the waveform at each trigger point. These files can be
recalled to the oscilloscope for later viewing. Choose File > Save Waveform and an Auto Save setting of Wrap
(overwrite when drive full) or Fill (stop when drive full). The files are saved in D:\Waveforms.

» AutoSave Table creates a .csv file of the result table data at each trigger point. Choose File > Save Table and an
Auto Save setting of Wrap or Fill. The files are saved in D:\Tables.

Caution: If you have frequent triggers, it is possible you will eventually run out of hard drive space. Choose
Wrap only if you're not concerned about files persisting on the instrument. If you choose Fill, plan to
periodically delete or move files out of the directory.
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Serial Decode

The methods described here at a high level are used by all Teledyne LeCroy serial decoders, differing only slightly for
signals with an embedded clock and separate clock and data signals.

Bit-level Decoding

The first software algorithm examines the embedded clock based on a default or user- specified vertical threshold
level. Once the clock signal is extracted, the algorithm examines the traffic to determine whether a data bit is high or
low. The default High and Low levels are automatically determined from a measurement of the amplitude of the
signals acquired by the oscilloscope. Alternatively, they can be manually set by the user. The algorithm intelligently
applies a hysteresis to the rising and falling edge of the serial data signal to minimize the chance of perturbations or
ringing on the edge affecting the data bit decoding.

Note: Although the decoding algorithm is based on a clock extraction software algorithm using a vertical
level, the results returned are the same as those from a traditional protocol analyzer using sampling point-
based decode.

Logical Decoding

After determining individual data bit values, another algorithm performs a decoding of the serial data message after
separation of the underlying data bits into logical groups specific to the protocol (Header/ID, Address Labels, Data
Length Codes, Data, CRC, Parity Bits, Start Bits, Stop Bits, Delimiters, Idle Segments, etc.).

Message Decoding

Finally, another algorithm applies a color overlay with annotations to the decoded waveform to mark the transitions
in the signal. Decoded message data is displayed in tabular form below the grid. Various compaction schemes are
utilized to show the data for the duration of the acquisition, from as little as one serial data message acquisition to
many thousands. In the case of long acquisitions, only the most important information is highlighted, whereas with
the shortest acquisition, all information is displayed with additional highlighting of the complete message frame.

User Interaction
Your interaction with the software in many ways mirrors the order of the algorithms. You will;
 Assign a protocol/encoding scheme and data sources to one of the four decoder panels on the Serial Data and

Decode Setup dialogs. Each decoder can utilize different protocols or data sources, or have other variations,
giving you maximum flexibility to compare different signals or view the same signal from multiple perspectives.

» Complete the remaining subdialogs required by the protocol/encoding scheme. Once there is an acquisition in
buffer, you will see a result table and an annotation overlay on the waveform trace showing the decoded data.

» Work with the annotated waveform, result table and other functionality to analyze the decoding.
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Decoding Workflow

We recommend the following workflow for effective decoding:

1. Set up the decoder using the lowest level decoding mode available, but do not yet enable it.

2. Acquire at least one complete transmission reasonably well centered on screen in both directions, with
generous idle segments on both sides.

Note: See Failure to Decode for more information about the required acquisition settings.

3. Stop acquisition, then enable the decoder. It will operate on the acquisition in buffer.

4. Zoom in on one decoded message to verify that transitions are being correctly decoded. Tune the decoder
settings as needed to produce a satisfactory decoding.

5. Once you are correctly decoding in one mode, continue making small acquisitions of five to eight
transmissions and run the decoder in higher level modes.

6. Finally, run the decoder on acquisitions of the desired length.

When you are satisfied the decoder is working properly, you can disable/enable the decoder as desired without
having to repeat this tuning process, provided the basic signal characteristics do not change.

Serial Decode Dialog

Choose Analysis > Serial Decode to access the serial decoder dialogs.

The Serial Decode dialog is best used to turn on/off decoders after they've been fully configured on the Decode
Setup dialog. You cannot make all required decoder settings here.

e Toturn on decoders, on the same row as Decode N, check On. If there is a valid acquisition, a result table and
annotated waveform will appear.

» Toturn off decoders, deselect the On boxes individually, or touch Turn All Off.
Note: If you change the Protocol to decode, the last settings configured for that protocol will be resumed.

If the decoder supports data search, use the Search button to open the Zoom dialogs. Enter search criteria on the
Search subdialog to the right of each Zn dialog.
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Decoder Set Up

Use Decode Setup and its subdialogs to configure decoders.
1. Choose Analysis > Serial Decode from the oscilloscope menu bar.

2. Onthe Serial Decode dialog, enable the decoder by checking On next to the decoder number. This may be
done any time, although we recommend having an acquisition in buffer before enabling the decoder.

3. Click the Setup button at the end of the row to open the Decode Setup dialog.

4. Select the highest-level Protocol to be decoded and the inputs (sources). The Protocol selection will influence
the remainder of the set up.

SENT Basic Subdialog

Basic Fast Ch Slow Ch Levels Tests

Viewing Physical Layer
Decode Type TickTime TickT Tol
Words 3.00 s 25 %
Channels Idle State Nibbles
Both IdleHigh 4 8

Format Protocol Details

Hex Version Pause
APR2016 4 Pulse

Select a Decode Type of Nibbles or Words. A separate row will appear in the result table for each nibble or word.
Choose to decode Fast Only, Slow Only, or Both Channels.
Choose the Format in which to show results: Hex(adecimal) or Dec(imal) .

Check Nibble Details if you wish to view the raw nibble values before rounding. Values are normally rounded off to
the nearest whole number. This selection will insert an individual row for each nibble in the message beneath the
word decoding in the SENT result table.

Enter the Tick Time—time in seconds between a nibble of value N and a nibble of value N+1.

Set a Tick Time Tol(erance). This defines how the CAL pulse is filtered with respect to the Tick Time. For example, if
a Tick Time of 3 us is set with a tolerance of 10%, the CAL pulse is expected to be
56 * 3 pus + 10%, therefore 168 ps + 10%.

Indicate where the Idle State(opposite of the pulse direction) lies , IdleLow or IdleHigh.
Enter the number of Nibbles that make up a word, from 5 to 8 (8 is the default).
Choose the Version of the protocol used in the decoded signal.

The algorithm expects a Pause Pulse as per the 2010 section 5.2.6 definition. The Pause Pulse follows the CRC of
message N and precedes the CAL pulse of message N+1. Check this box to decode the Pause Pulse.

Select the CRC type in use. If you are using the Jan 2010 or April 2016 protocol version, also select which of the
following to include in the CRC computation:

* New CRC—the CRC computation will be performed as per the 2010 or 2016 recommended implementation.

* SCN-—the Status and Communication Nibble is used.
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SENT SPC Subdialog

Slow Ch Levels

In addition to the SENT Basic settings described above, enter the Master Trigger Pulse Length(s) that initiate the
transfer of data from up to four sensors in ID 0 through ID 3. This will enable you to decode and filter transmissions
from particular sensors. You need only enter those pulse lengths that are in use; any that are not found in the stream
are ignored, so you can leave them as is.

In addition to the CRC type and SCN use, also select whether to use:

 |D—Identifier (0 - 3) of the sensor sending the message, matching the MTP length you entered on the dialog.

Note: If you wish to decode sensor IDs, be sure to assign each a unique MTP both in the decoder and
in your system design. If you interrogate two sensors with pulses of the same length, the software will
decode the response, but the message will fail the CRC check when you have chosen to decode ID, as
well.

« RC—Rolling Counter identifying the (virtual) sequence number of a message from a given sensor. This field is
used primarily for tuning the decoder, ensuring that the CRC is being properly computed. To use it, check the
box, then enter an RC Val(ue) starting from O until any CRC error messages in the decoder table disappear.
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Fast Channel Subdialog

Fast Ch Slow Ch

Order
MEN

MSN
MSN
MSN

The Fast Channel dialog will appear if you selected a Decode Type of “Words” and Channels is set to either “Fast” or
"Both.”

The SENT protocol specifies four user-defined data fields, DO through D3. Each of these can be used to present the
content of the message payload as it was programmed. Select each that you wish to decode, then specify the
payload interpretation.

Filter Dx Errors removes potentially incorrect DO-D3 values from the result table when an error occurs in the SENT
message so that they cannot be used by downstream processes such as graphs and measurements. If you would
prefer to see the error data in the table, deselect this box.

Interpretation of Offset defines the units in which the message Offset is entered: Bits, Nibbles or High Speed nibbles.
Select Bits only when there is a need to save bits so that more information can be compacted into the relatively short
message. Select High Speed only when decoding High Speed SENT.

Check Active to decode the corresponding user-defined data field.

In Offset, enter the number of Bits, Nibbles, or High Speed Bits that constitute the message offset (i.e., the position
from which to start decoding content).

Enter the number of Nibbles in the payload.

Select whether data is presented in LSN or MSN Order.

10
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Slow Channel Subdialog

Basic Fast Ch Slow Ch Levels Tests Q CLOSE

Slow Channels Symbolic Decode

D-\Applications\SENT\SlowChanDefFile txt Prowsg

The Slow Channel dialog will appear if you selected a Decode Type of “Words” and Channels is set to either “Slow
Only” or “Both.” The Slow Only option takes a single data value from each of 16 or 18 SENT message packets and
builds a Slow Channel result, displayed on the decoder result table.

A plain text Slow Channel Definition File (SCDF) is used to decode this data into a more meaningful presentation of
the assimilated slow channel data. It is expected that different sensors will require different SCDF files. See SCDF
File Structure for formatting instructions.

On the Slow Channel dialog, select the User Defined Tables field and Browse to the SCDF file to use for this purpose.

0 Tip: To simplify uploading a new SCDF file, first copy it to oscilloscope directory D:\Applications\Sent.

Levels Subdialog

Fast Ch Slow Ch Levels Tests Q CLOSE

Enter the vertical Level used to determine the edge crossings of the signal. This value will be used to determine the
bit-level decoding.

Optionally, enter a Hysteresis band value. For guidelines, see Setting Level and Hysteresis.

11
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Tests Subdialog

Basic Fast Ch Slow Ch

0 are faulted

es are faulfed

The Test dialog enables you to apply any of four SAE test criteria (the text on the dialog describes the test). Select
each test to apply, then enter the value that completes the statement. Results are shown in the decode table as a
text message in the Status column and a Numerical output in the S column.

See SAE Test Results for more information.

SCDF File Structure

The mechanism used to translate SENT IDs and values is a simple TXT file containing table definitions. The
beginning of the SCDF default file installed on every instrument is shown here:

| SlowChanDefFile.txt - Notepad =n =R
File Edit Format VYiew Help

£ -
£ Syntax description at the end of the SCDF file

£

/i - - - -

// Slow Hessages Definition Table for 8 bit message ID, max is 254

I - - - -
Table,5lowChannel8BitHessagelD

8,Undefined

1,Diagnostic Code /f interpreted as per user defined Table DiagnosticHessages
2 Undefined

3,5ensor Class /7 interpreted as per user defined Table SENTSensorClasses
4 Undefined

% ,Manufacturer Code /f interpreted as per user defined Table HanufacturerCodes
6 ,SENT Rew /f interpreted as per user defined Table SENTRevisionCodes
7-254 ,0EM defined

m

£ -== -== -==

// S5low Hessages Definition Table for 4% bit message ID, max is 15
I --- --- --- ---
Table,SlowChanneliBitHessagelID|

8-15 ,User Defined

i -—- -—- -—- -—-
f/ Slow Hessages Definition Table for SENT rev, max is 9

£ -== -== -== -==
Table,SENTRevisionCodes

@,Undefined Reu

1,Reu 1

2,Rev 2

3,Rev 3

4-9,.Future Reus

4 n 3

12
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Reserved Names
The SCDF syntax defines several reserved names to identify the auxiliary tables used for:

e Table, SlowChannel8BitMessagelD, used to interpret the 8 bit message ID

Table, SlowChannel4BitMessagelD, used to interpret the 8 bit message ID

Table, SENTRevisionCodes, used to interpret the value conveyed by message ID 6

Table, SENTSensorClasses, used to interpret the value conveyed by message ID 3

Table, DiagnosticMessages, used to interpret the value conveyed by message ID 1

Table, ManufacturerCodes, used to interpret the value conveyed by message ID 5

Syntax Errors
The syntax is documented in the file itself as comments toward the end, as well as the syntax errors detected during
the parsing.

| SlowChanDefFile.txt - Notepad =n =R

File Edit Format VYiew Help

I - SYNTAX EXPLAMATION - -—=

£

// This file drives the constitution of several tables, whose names are defined in
// the statements of the form:

ii <Table,TableName>

iﬁ Each statement of this type sets the “Current Table™

ii Each table line definition consists of a statement of the form:
ii <LineX, Text>

i <LineStart-LineEnd, Text>

£

/¢ The first version will £ill Line ¥ with "Text" of the "Current Table"

// The second version will fill a Table region from LineStart to LineEnd

£/ with “Text™ of the "Current Table™

£

£

/¢ The "LineX", "LineStart", LineEnd"" keywords must be Decimal or Hexadecimal.

// A Decimal Line value must contain only values: 8123456789

/4 An Hexadecimal Line value must begin with 8% followed by Hex digits

/4 Hex digits are: B12345678%9abcdefABCDEF

£

// The <LineStart-LineEnd, Text> syntax allows filling of the table with very few Line
// statements. This feature is used i.e in the default SCDF, or for test purposes.

7

// At boot time all of the tables are filled with default texts beginning with "=+

£ -

Fl [T 3

m

Parsing errors are listed at the very end of the file. Note that the parsing errors are very useful when beginning to use
the SCDF, in order to located syntax errors. The syntax is very strict, in order to keep the parser as simple as
possible.

13
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J SlowChanDefFile.txt - Notepad EI@
File Edit Format VYiew Help

/# At boot time all of the tables are filled with default texts beginning with *'»+" -
'L

I SYNTAX ERRORS EXPLANATION ——----——--———--———-————

I

// 1-Line Ualue and Range Syntax Errors

'L

f¢ ULine XX, index ¥YY out of range (8 to Max Line for Current Table) i.e 1234,%o0me 4 bit ID message

/# “Line ¥X has more then 1 '-' separator in Line Range: ™ i.e 1-3-8,User Text

/# “Line XX, Line Range has Start:S85 > End:EE" i.e. 25-4,User Text

/¢ "Line XX, line contains non digits on position %d: ™ i.e 243, User Text

I

// 2-General Line Syntax Errors

'L

/f “Line ¥X has CC Commas Instead Of 1

/# “Line ¥X has No Commas™

/¢ "Table Line Definition XX Has UU Tokens Instead Of 2"
/¢ ULine XX, Line Definition exceeds 18 characters™

f# “Line %X, Hessage Length YY exceeds 60 characters"

21,User Text,,,,

A Line without commas
34,User Text1,User Text?
12345-13345 ,User Text
3,5ome Very Long User Text

e e e e e e
mMmMmMMIMMD

/# “Line ¥X, Warning,empty Hessage?" 3.

'L

/{ 3-Table Selection Syntax Errors

I

// “Line ¥X, Warning: Table at ¥¥ replaced by User Entry " Line is redefined

/¢ “Line XX defines a table line, but no table is selected” Line Definition starts before Table Definition

/¢ ULine XX, unknown error, rejects all tokens™ Catch all when Line Parser is overwhelmed £
/¢ "Table Selector Definition %d Has %d Tokens Instead OF 2™ i.e. Table,ManufacturerCodes,Some Hore Useless Text

/# “Line XX specifies unknown Table" i.e. Table,UnknownTableName

In addition to the SCDF file, parsing errors are always emitted at the bottom of the oscilloscope screen, with the last
error overwriting the previous ones. It is therefore advisable to fix the errors as they occur, beginning with the last
emitted error, then reload the file and see if any errors are left.
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Setting Level and Hysteresis

The Level setting represents the logical level for bit transition, corresponding to the physical Low and High
distinction. Level is normally set as 50% of waveform amplitude, but can sometimes be set as an absolute voltage
(with reference to the waveform 0 level).

Percent mode is easy to set up because the software immediately determines the optimal threshold, but in some
cases it might be beneficial to switch to Absolute mode when available:

» On poor signals, where Percent mode can fail and lead to bad decodes
» On noisy signals or signals with a varying DC component
» On very long acquisitions, where Percent mode adds computational load

The transition Level appears as a dotted, horizontal line across the oscilloscope grid. If your initial decoding indicates
that there are a number of error frames, make sure that Level is set to a reasonable value.

The optional Hysteresis setting imposes a limit above and below the measurement level that precludes
measurements of noise or other perturbations within this band.

A blue marker around the Level line indicates the area of the hysteresis band. Depending on protocol, the Hysteresis
Type may be percent amplitude, vertical grid divisions or absolute voltage level.

Observe the following when setting Hysteresis:
» Hysteresis must be larger than the maximum noise spike you wish to ignore.

» The largest usable hysteresis value must be less than the distance from the level to the closest extreme value
of the waveform.

Hysteresis set as 40 percent of total waveform amplitude (left) and Hysteresis set as equivalent of 1 grid division
(right) around an absolute -200mV Level setting.

Note: Usually, you can set the Level and Hysteresis in different modes. For a few protocols, there is only one
option for setting Level or Hysteresis.
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Decoding Digital Inputs

While digital lines can be used as sources for most decoders, it is important to make sure that the logic setup for the
digital inputs is consistent with the levels set for the decoder and appropriate for the signal.

If you receive a poor decoding when using digital inputs, do the following to troubleshoot.

Assess Signal Levels Using Analog Input
It is good practice to establish the exact signal characteristics using an analog input method prior to using a digital
input method.

Connect the signal to an oscilloscope channel (Cn) and set the amplitude, top and base measurement parameters
on it. If the decoder utilizes multiple sources, do this for all signals.

Open the decoder setup dialogs and try decoding the analog signal using the default levels. Adjust Level and
Hysteresis according to the measured amplitude until you get a good decoding of the analog signal.

Set Appropriate Logic Levels on Digital Dialogs

When a digital input device is connected to the oscilloscope, setup dialogs for digital groups (Digitaln) are added to
the Vertical menu. Use the Digitaln dialogs to set the levels used for logic determination by the input device.

Note; Digital is turned on by default with all the lines added to the group.

Open the Logic Setup tab and either select a Logic Family that is appropriate to the signal amplitude, or choose User
Defined and enter your custom logic Threshold and Hysteresis levels based on what you determined when decoding
the analog signal.

Tip: Selecting different Logic Families will display what determination Threshold and Hysteresis values they
use on the dialog.

For example, a signal with approximately 1.25 V amplitude, 0 V based, does not match any of the Logic Families but
lends itself to a User Defined setup with Threshold at 0.625 V (~50%) and a Hysteresis of 100 mV if the edges are
clean.

Continue to adjust your digital group Logic Setup and your decoder Levels in synch until you receive a good digital
decoding.

Note: For the MSO Digital Leadset, logic can only be set per digital leadbank, not line by line as on the
HDA125. Be sure the lines you use for decoding are all from the same leadbank and set appropriately.
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Failure to Decode

Several conditions may cause a decoder to fail, in which case a message will appear in the first row of the summary
result table, instead of in the message bar as usual. In these cases, the decoding is turned off to protect you from
incorrect data. Adjust your acquisition settings accordingly, then re-enable the decoder.

All decoders will test for the condition Too small amplitude. If the signal's amplitude is too small with respect to the
full ADC range, the message “Decrease V/Div" will appear. The required amplitude to allow decoding is usually one
vertical division.

If the decoder incorporates a user-defined bit rate (usually these are protocols that do not utilize a dedicated
clock/strobe line), the following two conditions are also tested:

» Under sampled. If the sampling rate (SR) is insufficient to resolve the signal adequately based on the bit rate
(BR) setup or clock frequency, the message "Under Sampled" will appear. The minimum SR:BR ratio required is
4:1. Itis suggested that you use a slightly higher SR:BR ratio if possible, and use significantly higher SR:BR
ratios if you want to also view perturbations or other anomalies on your serial data analog signal.

» Too short acquisition. If the acquisition window is too short to allow any meaningful decoding, the message
“Too Short Acquisition” will appear. The minimum number of bits required varies from one protocol to another,
but is usually between 5 and 50.

However, there are no tests for the following, so you will want to pay attention to:

« Poor signal quality. Care must be taken when probing high speed serial data signals (typically with a high
bandwidth differential probe). Channel loss, reflections and probe loading can degrade the signal. Its best to
probe at the termination of a high speed serial link to minimize probe loading effects and reflections. If the
signal has significant channel loss, CTLE/DFE equalizers can be used to improve the quality of the signal being
decoded. Use the waveform output by the equalizer as the input to the decoder.

* Incorrect Threshold Levels. Configuring an incorrect threshold level can result in no, incomplete or incorrect
decoding. With analog traces, the threshold level can be adjusted after the acquisition but this is not possible
with digital waveforms. You must make sure that the appropriate logic levels are configured for digital inputs,
as described in the Decoding Digital Inputs, before data is acquired. When troubleshooting, it is best to use
analog channels instead of digital channels because of the additional information available.

Note: It is possible that several conditions are present, but you will only see the first relevant message in the
table. If you continue to experience failures, try adjusting the other settings.
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Reading Waveform Annotations

When a decoder has operated successfully on a valid acquisition, an annotated waveform appears on the
oscilloscope display, allowing you to quickly see the relationship between the protocol decoding and the physical
layer. A colored overlay marks significant bit-sequences in the source signal: Header/ID, Address, Labels, Data
Length Codes, Data, CRC, Parity Bits, Start Bits, Stop Bits, Delimiters, Idle segments, etc. Annotations are customized
to the protocol or encoding scheme.

The amount of information shown on an annotation is affected by the width of the rectangles in the overlay, which is
determined by the magnification (scale) of the trace and the length of the acquisition. Zooming a portion of the
decoded trace by clicking a line in the table will reveal the detailed annotations.

SENT Decoded Waveform Annotations

Annotation Overlay Color (1) Text (2) (3)
Message Burst Navy Blue Message <ID>
(behind data fields)
Pause Pulse Dark Green Pause Pulse = <time>
Syncronization Pulse Grey Synchronization Pulse = <time>
Status & Communication Bits Purple S&C = <value>
Payload Data Aqua Blue [Word | Nibble] = <value>
Cyclic Redundancy Check Royal Blue CRC = <value>

1. Combined overlays affect the appearance of colors.
2. Textin brackets < > is variable. The amount of text shown depends on your zoom factors.
3. Data values are shown in Nibbles or Words depending on your decoder selection.

COUOVOVVCLVVVCL OBV IVVTOCIVCV OV IV VOV VDOV OOV IVCVVOVC U BVVC VO VOOV TSV OV T TUD DUV OGOV V0OV VB0 D OOBOOTO DD GOV DU DO DD D

Zoomed waveform annotations, showing decoded data.
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SENT SPC Decoded Waveform Annotations

Annotation Overlay Color (1) Text (2) (3)
Message Burst Navy Blue Message <ID>

(behind data fields)
Pause Pulse Dark Green Pause Pulse = <time>
Master Trigger Pulse Olive Master Trigger Pulse = <time>
Sensor Response Pulse Aqua Blue Sensor Response Time = <time>
Syncronization Pulse Grey Synchronization Pulse = <time>
Payload Data Aqua Blue [Word | Nibble] = <value>

1. Combined overlays affect the appearance of colors.
2. Textin brackets < > is variable. The amount of text shown depends on your zoom factors.
3. Data values are shown in Nibbles or Words depending on your decoder selection.

Pause Pulse = 848.42 s

Message 1 5 Nibbles

-1.9567 ms

Pause Pulse = 848,92 s

g
=
il
¥
&

J

1ms

Zoomed waveform annotations, showing decoded data.
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Serial Decode Result Table

When you choose to turn On or to View Decode, provided there is a valid acquisition to decode using that protocol, a
table summarizing the decoder results appears below the grids. This result table shows all data decoded during the
most recent acquisition, even when there are too many bursts for the waveform annotation to be legible.

Tip: The result table does not have to be visible in order for the decoder to function. Hiding the table can
improve performance when your aim is to use the decoding in downstream processes, like measurements.

Table Rows
Each row of the table represents one index of data found within the acquisition. What exactly this represents
depends on the protocol and how you have chosen to "packetize" the data stream when configuring the decoder.

When multiple decoders of different protocols are run at once, the rows are interleaved in a summary table, ordered
according to their acquisition time. The Protocol column is colorized to match the input source that resulted in that
index of data.

Note: The interleaved summary table will default to the lowest common decoding (e.g., hexadecimal if both
support that, but only one supports symbolic).
You can change the number of rows displayed on the table at one time. The default is five rows.

Swipe the table up/down or use the scrollbar at the far right to navigate the table. See Using the Result Table for
more information about how to interact with the table rows to view the decoding.

Table Columns

When a single decoder is enabled, the result table shows the protocol-specific details of the decoding. This detailed
result table may be customized to show only selected columns. When two or more decoders are enabled, a
summary result table combining results from all decoders shows these column:

Column Extracted or Computed Data

Index Number of the line in the table
Time Time elapsed from start of acquisition to start of message
Protocol Protocol being decoded

Message Message identifier bits

Data Data payload
CRC Cyclic Redundancy Check sequence bits (if used)
Status Any decoder messages; content may vary by protocol

~Protocol ~Messaae Status

hohohh b ohohok

e, with results from different protocol decoders interleaved on one table.

=

Example summary result tab

When you select the Index number from the summary result table, the detailed results for that index drop-in below it.
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~Protocol  ~Message Status

4
N |
.. 4

4

|

Stat b0 b1 bz b3 DO D1 Status.
25: 8Nibbles 2Words 9 1.0 0 1 1 3807
ge 2 BNibbl._. 4

Example summary result table showing drop-in detailed result table.

Exporting Result Table Data

You can manually export the detailed result table data to a .CSV file:
1. Choose Analysis > Serial Decode and open the Decode Setup tab.
2. Optionally, touch Browse and enter a new File Name and output folder.
3. Touch the Export Table button.

Export files are by default created in the D:\Applications\<protocol> folder, although you can choose any other folder
on the oscilloscope or any external drive connected to a host USB port. The data will overwrite the last export file
saved, unless you enter a new filename.

Note: Only rows and columns displayed are exported. When a summary table is exported, a combined file is
saved in D:\Applications\Serial Decode. Separate files for each decoder are saved in
D:\Applications\<protocol>.

The Save Table feature will automatically create tabular data files with each acquisition trigger. The file names are
automatically incremented so that data is not lost. From the oscilloscope menu bar, choose File > Save Table and
select the desired Decode N as the source.

21



SENTbus TDME Instruction Manual

SENT Result Table

This extracted data appears on a SENT detailed result table. Columns can be hidden by customizing the result table.

Column Extracted or Computed Data

Index Number of the line in the table
Time(uS) Time (in microseconds) relative to the trigger of the beginning of the SENT burst
Sync Measured length of the synchronization pulse. The pulse width is measured between the two falling

edges of the sync pulse, at the intersection of the signal and the Level selected on the Level dialog.
Note that a large hysteresis will impact this value.

Tick Tick Time; value of the sync pulse divided by 56

Msg Message summary, with the number of transitions, nibbles and words

RMS Root Mean Square value of the falling edge crossings, usually in nanoseconds

Pause P(ulse) Time from the end of one burst to the beginning of the next burst

S Status Bit: 0 when Status is empty (no errors), 1 or greater when errors are reported. The S column
can be used with measure, math, and analysis features explained later.

Status Reported errors and warnings

When decoding Nibbles...

Nibbles Number of nibbles

When decoding Words...

Stat Value of the status and communication (S&C) nibbles. This value is split into its component bits in
the next four columns to help interpret the contents. Component bits are chromacoded for quick ref-
erence to their result values in the ID, Data, and CRC columns.

b0-b1 Reserved for special applications

b2 Message data bits (slow channels)

b3 Message start bits

DO-D3 Message data bits (fast channels)

ID Result value of 8-bit ID

Data Result value of 12-bit data

CRC Value of the CRC (error detection) nibble compared to values of the other nibbles of the message. If
it does not match, an error appears in the Status column. It is normal that the first and last mes-
sages of a record, when truncated, generate a CRC error.

+Sync -~ Tick - Stat +b0~b1~b2~b3~-D0  +D1  ~ID ~Data~CRC ~RMS ~Pause P~ S Status
0 0.0 0 2742 2373 6 19ns 3656us 0
1 2744 £ 9
0 2747 12
0 2750 3 3
0 2752 15
0 2755 10
0 2757 0
0 2760 84 10

8 0
4 0
0 0
4 0
0 0
0 0
0 0

0
0
0
0
0
0
0

[SENT R +~Sync - Tick ~Stat ~ b0 ~b1~b2-b3~ID -Data ~CRC ~RMS~Pause P~ 5 Status
1 15696 ms 162.1us 289 us ‘Message 1. BMNibbles 0 Words 0 0 0 0 0 B 4e-3 1865us 0
Raw Mibble 0 :-0.0005 A: -5.403e-04 A”2::2 919e-07
Raw Mibble 1:04.0026 A: 2.591e-03 Ar2: 6.712e-06
Raw Mibble 2 :00.9986 A: -1.439e-03 A~2: 2.071e-06
Raw Mibble 3 :06.0000 A: 16e-05 Ar2: 1.456e-09
Raw Nibble 4 :04.9985 A: -1.550e-03 Ar2: 2.402e-06
Raw Nibble 5 :03.0097 A: 9.683e-03 A*2: 9.377e-05
Raw Mibble 6 :12.0039 A: 3.850e-03 Ar2: 1.483e-05
Raw Nibble 7 :05.999¢ A: -3.984e-04 An2: 1.587e-07
RMS: 3.877e-03
11 14878 ms 162.1us 289 us Message 11: 8Nibbles 0Words 0 0 0 0 2e-3 16.41us 0
Raw Nibble 0 :00.0003 A: 2.701e-04 AA2: 7.2932-08

SENT result table with nibble details.
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SENT SPC Result Table
In addition to the columns above, the result table will show the following when decoding SENT SPC:

Column Extracted or Computed Data

MT Pulse Measured length of the Master Trigger Pulse (MTP)
RespT Measured response time from MTP to the sensor response
ID ID of the sensor sending the message, 0 through 3

"MTPulse"RespT -ID-Sync ~Tick ~Msg ~Nibbles “RMS ~Pause P ~S Status

3251 s 2734 ps 488ns Message 2: 5 Nibbles 60e-3 849.0 us
-32.439 ys  32.50 ps 27.35us 488ns Message 3: 5 Nibbles 62e-3 B48.4 us
967.784 us 32.50 ps 2734 ps 488ns Message 4: 5 Nibbles 64e-3 8489 us
1.9675ms 32.50 ps 27.35us 488ns Message 5: 5 Nibbles 66e-3 848.4 us

SENT SPC detailed result table.

b2 b3 00 D1 I Data C In addition to the decoded bit values, the SENT table displays color-coding
T - : of Status and Communication (S&C) bits so that it is easy to recognize how
ol E they are distributed over 16 or 18 Fast Messages. The resulting bit

1

1

: :"' transmission is shown in the ID, Data, and CRC columns.
1

1

1

1

Bits Color Code

T

R T T

a Sync pattern Grey

: 4-bit or 8-bit ID Red
12-bit Data Green
Control bit: Turquoise

When 0, ID is 8-bits and Data 12-bits wide
When 1, ID is 4-bits and Data 16-bits wide

4-bit or 6-bit CRC Blue

SENT Errors
These messages may appear in the Status column of the SENT detailed result table. The corresponding status bit
value appears in the S column.

Channel Error Status Message S Value
Fast Nibble value outside range 0-15 %d Nibble(s) wrong! 1
Fast Sync outside range + 25% of Sync computed as %f Sync outside range 1
56 * user TickTime
Fast Fast channel CRC error FC CRC error 1
Slow Enhanced Slow Message bit 7, 13 or 18 is B[7]13]18] = 0! 1
not 0
Slow Enhanced Slow Message CRC error SC(18) CRC Error 1
Slow Legacy Slow Message CRC error SC(16) CRC Error 1
Compound Fast More than Nin 100 errors %d 100 messages faulted 2
Compound Fast More than N consecutive errors %d consecutive messages faulted 3
Compound Fast Counter error Counter D%x faulted 4
Compound Fast CAL > % from prev Sync faulted 5
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SAE Test Results
The results of SAE tests are populated to the Status and S columns of the result table:

 Status shows a description of the error

e Sshows Qif there is no error, 1 or greater when an error appears, making it an error flag that can be tracked
statistically or exploited for measurements and Pass/Fail testing.

value
status
SENT i Stat b0

4.70797300 5 669
4.71135300 5 &8
s 7C CRC error +2 Nibble(s) wrong! +0.000908 Sync outside range

In the example above:
e Aglitchinrecord 1611 appears as 1 in the S column.
e P1isMsgToValue set to "pass thru" column S values.

» Pass/Fail test Q1 is set to fail whenever P1 is not "less than 1" (P1 < 1 = False), meaning it is not an error free 0.
The "fail" could in turn be set up to trigger any number of other actions.

Note: It is not necessary to display the measurement source trace in order for the SAE test results to be
used this way.
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Using the Result Table

Besides displaying the decoded serial data, the result table helps you to inspect the decoding.

Zoom & Search

Touching any cell of the table opens a zoom centered around the part of the waveform corresponding to the index.
The Zn dialog opens to allow you to rescale the zoom, or to Search the decoding. This is a quick way to navigate to
events of interest in the acquisition.

0 Tip: When in a summary table, touch any data cell other than Index and Protocol to zoom.

The table rows corresponding to the zoom are highlighted, as is the zoomed area of the source waveform. The
highlight color indicates the zoom shown (Z1 yellow, Z2 pink, etc.). As you adjust the zoom scale, the highlighted
area may expand to several rows or fade to indicate that only a part of that Index is now shown in the zoom.

When there are multiple decoders running, each can have its own zooms of the decoding open at once. In this case,
multiple rows of the summary table are highlighted to show which indexes are shown in the zooms. These highlights
will be different colors to indicate which rows correspond to each decoder.

Note: The zoom number is no longer tied to the decoder number. The software tries to match the numbers,
but if it cannot it uses the next empty zoom in the sequence.

Status

-2 ns qe
21.042 ms S Message 26: 8 Nibbl..
20832 ms SN Ve 10- 2 Nibbl__
2 ns... ETSULIN \es sac

Filter Results
Columns of data with a drop-down arrow in the header cell can be filtered: i TG <

Touch the column header cell to open the Decode Table Filter dialog. Select Enable to turn on the column filter;
deselect it to turn off the filter. Use the Disable All button to quickly turn off multiple filters.

Select a filter Operator and enter a Value that satisfies the filter condition.

Decode Table Filter fo
Enable

Greater than

Value

2.000000 ms

Disable All

Operators Data Types Returns

N

Numeric or Text [ Exact matches only
Numeric All data that satisfies the operator

\%
v
A
IA
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Operators Data Types Returns

In Range, Out Range Numeric All data within/without range limits

Equals Any (on List), Text All data that is/is not an exact match to any full value on the list. Enter a

Does Not Equal Any (on List) comma-delimited list of values, no spaces before or after the comma,
although there may be spaces within the strings.

Contains, Does Not Contain Text All data that contains or does not contain the string

Note: Once the Operator is selected, the dialog shows the Value format that may be entered. Numeric
values must be within .01% tolerance to be considered a match. Text values are case-sensitive, including
spaces within the string.

Those columns of data that have been filtered will have a funnel icon (similar to Excel) in the header cell, and the
index numbers will be colorized.

HaMiTime +Sync_ ~Msa + Stat v b0~
3 2379 8233 3. B Mibbles 2 Words : 0
5. 8 Nibbles 2
4: & Nibbles 2
5. B Nibble:
Mess : B Mibbles :
Message 17: 8 Nibbles 2 Words

e

[ H
3

THE
ERE

3
ith th LA th ith

[ T o T o T o T T 7

1
1
1
1

— it

e

Example filtered decoder table.
On summary tables, only the Time, Protocol, and Status columns can be filtered.

If you apply filters to a single decoder table, the annotation is applied to only that portion of the waveform
corresponding to the filtered results, so you can quickly see where those results occurred. Annotations are not
affected when a summary table is filtered.

Also, eye diagrams are modified to represent only the filtered results, which can help to identify exactly which indices
of data are the cause of signal integrity problems.

View Details
When viewing a summary table, touch the Index number in the first column to drop-in the detailed decoding of that
record. Touch the Index cell again to hide the details.

If there is more data than can be displayed in a cell, the cell is marked with a white triangle in the lower-right corner.
Touch this to open a pop-up showing the full decoding.

Data

A

Navigate
In a single decoder table, touch the Index column header (top, left-most cell of the table) to open the Decode Setup
dialog. This is especially helpful for adjusting the decoder during initial tuning.

When in a summary table, the Index column header cell opens the Serial Decode dialog, where you can
enable/disable all the decoders. Touch the Protocol cell to open the Decode Setup dialog for the decoder that
produced that index of data.
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Customizing the Result Table

You may customize the size of the result table by changing the Table # Rows setting on the Decode Setup dialog.
Keep in mind that the deeper the table, the more compressed the waveform display on the grid, especially if there are
also measurements turned on.

Performance may be enhanced if you reduce the number of columns in the result table to only those you need to
see. It is also especially helpful if you plan to export the data.

1. On the Decode Setup tab, touch the Configure Table button.

2. On the View Columns pop-up dialog, mark the columns you want to appear and clear those you wish to
remove. Only those columns selected will appear on the oscilloscope display.

Note: If a column is not relevant to the decoder as configured, it will not appear.

To return to the preset display, touch Default.
3. Touch the Close button when finished.

You may also use the View Columns pop-up to set a Bit Rate Tolerance percentage. When implemented, the
tolerance is used to flag out-of-tolerance messages (messages outside the user-defined bitrate +- tolerance) by
colorizing in red the Bitrate shown in the table.
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Searching Decoded Waveforms

Touching the Action toolbar Search button button on the Decode Setup dialog creates a 10:1 zoom of the center of
the decoder source trace and opens the Search subdialog.

Touching the any cell of the result table similarly creates a zoom and opens Search, but of only that part of the
waveform corresponding to the index (plus any padding).

0 Tip: In summary table mode, touch any cell other than Index and Protocol to create the zoom.

Basic Search

On the Search subdialog, select what type of data element to Search for. These basic criteria vary by protocol, but
generally correspond to the columns of data displayed on the detailed decoder result table.

Optionally:

e Check Use Value and enter the Value to find in that column. If you do not enter a Value, Search goes to the
beginning of the next data element of that type found in the acquisition.

 Enter a Left/Right Pad, the percentage of horizontal division around matching data to display on the zoom.
e Check Show Frame to mark on the overlay the frame in which the event was found.

After entering the Search criteria, use the Prev and Next buttons to navigate to the matching data in the table,
simultaneously shifting the zoom to the portion of the waveform that corresponds to the match.

The touch screen message bar shows details about the table row and column where the matching data was found.

& |dx= 15 (decimal) found at Row 55 Column 0 going Left

Advanced Search

Advanced Search allows you to create complex criteria by using Boolean AND/OR logic to combine up-to-three
different searches. On the Advanced dialog, choose the Col(umns) to Search 1 - 3 and the Value to find just as you
would a basic search, then choose the Operator(s) that represent the relationship between them.
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Decoding in Sequence Mode

Decoders sometimes can be applied to Sequence Mode acquisitions. In this case, the index numbers on the result
table are followed by the segment in which the index was found and the number of the sample within that segment:
index (segment-sample).

Time vFormat ~ID ~|DE~RTR-DLG Data
972882 ms Std 0x400 0 0 2 Ga 6b
19.7527 ms Std (=400 2 Ga 6b
30.2558 ms Std 0x400 2 ba 6b

40.1663 ms Std 0x400 2 Ga 6b

59 8595 ms 2 ba 6b
69.8913 ms 2 6a 6b
804032 ms S 2 Ga 6b
899384 ms S 2 ba 6b
99.9688 ms 2 6a 6b

Example filtered result table for a sequence mode acquisition.

In the example above, each segment was triggered on the occurrence of ID 0x400, which occurred only once per
segment, so there is only one sample per segment. The Time shown for each index in a Sequence acquisition is
absolute time from the first segment trigger to the beginning of the sample segment.

Otherwise, the results are the same as for other types of acquisitions and can be zoomed, filtered, searched, or used
to navigate. When a Sequence Mode table is filtered, the waveform annotation appears on only those segments and
samples corresponding to the filtered results.

Note: Waveform annotations can only be shown when the Sequence Display Mode is Adjacent. Annotations
are not adjusted when a Sequence Mode summary table is filtered, only the result table data.

Multiple decoders can be run on Sequence Mode acquisitions, but in a summary table, each decoder will have a first
segment, second segment, etc., and there may be any number of samples in each. As in any summary table, the
samples will be interleaved and indexed according to their actual acquisition time. So, you may find (3-2) of one
decoder before (1-1) of another. Filter on the Protocol column to see the sequential results for only one decoder.
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Improving Decoder Performance

Digital oscilloscopes repeatedly capture "windows in time". Between captures, the oscilloscope is processing the
previous acquisition. The following suggestions can improve decoder performance and enable you to better exploit
the long memories of Teledyne LeCroy oscilloscopes.

Where possible, decode Sequence Mode acquisitions. By using Sequence mode, you can take many shorter
acquisitions over a longer period of time, so that memory is targeted on events of interest.

Note: For some protocols, the Serial Trigger does not support Sequence Mode acquisitions, although you
could still decode Sequence Mode acquisitions made using a different trigger type.

Parallel test using multiple oscilloscope channels. Up-to-four decoders can run simultaneously, each using different
data or clock input sources. This approach is statistically interesting because multi-channel acquisitions occur in
parallel. The processing is serialized, but the decoding of each input only requires 20% additional time, which can
lessen overall time for production validation testing, etc.

Avoid oversampling. Too many samples slow the processing chain.

Optimize for analysis, not display. The oscilloscope has a preference setting (Utilities > Preference Setup >
Preferences) to control how CPU time is allocated. If you are primarily concerned with quickly processing data for
export to other systems (such as Automated Test Equipment) rather than viewing it personally, it can help to switch
the Optimize For: setting to Analysis.

If your goal is downstream processing, turn off tables, annotations, and waveform traces. As long as downstream
processes such as measurements or Pass/Fail tests reference a decoder, the decoder can function without actually
displaying results. If you do not need to see the results but only need the exported data, you can deselect View
Decode, or minimize the number of lines in a table. Closing input traces also helps.

Decrease the number of rows and columns in tables. Only the result table rows and columns shown are exported. It
is best to reduce tables to only the essential columns if the data is to be exported, as export time is proportional to
the amount of data exchanged.
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Measure/Graph

Measure/Graph

Not supported on WaveSurfer and HDO4000 series oscilloscopes.

The installation of the Measure/Graph package (included with "ME" and "MP" options) adds a set of measurements
and plots designed for serial data analysis to the oscilloscope's standard measurement capabilities. Measurements
can be quickly applied without having to leave the waveform or tabular views of the decoding.

Note: This capability will only function properly if an "ME" or "MP" option for the protocol decoded is
installed, although the dialogs will appear if any Measure/Graph options are installed.

Serial Data Measurements

These measurements designed for debugging serial data streams can be applied to the decoded waveform.
Measurements appear in a tabular readout below the grid (the same as for any other measurements) and are in
addition to the result table that shows the decoded data. You can set up as many measurements as your
oscilloscope has parameter locations.

Note: When working outside the TDME software, measurements appear in the Serial Decode sub-menu of
the Measure Setup menu and may have slightly different names. The measurements are made the same.

Measurement Filters Description

View Serial Encoded Data as Simplified set up of a Message to Value parameter and graph. Performs a

Analog Waveform Digital-to-Analog Conversion (DAC) of the embedded digital data and dis-
plays it as an analog waveform.

Message to Value ID, Value Extracts a selected portion of the decoded data to a measurement para-
meter location, with optional conversion of value. Data may be selected by
ID and/or data field position.

Column to Value Column Extracts the data in a single column of the result table to a measurement
parameter location, with no transformation of value.

Message to Analog ID, Data, Analog, | Computes time from start of first message that meets conditions to cross-

Column ing threshold on an analog signal. If the analog condition precedes the

message condition, no measurement is performed.

Message to Message ID, Data, Column | Computes time from start of first message that meets conditions to start
of the next message that meets conditions.

Time at Message ID, Data, Column | Computes time from trigger to start of each message that meets con-
ditions.

Analog to Message ID, Data, Analog, |Computes time from crossing threshold on an analog signal to start of

Column first message that meets conditions. If the message condition precedes

the analog condition, no measurement is performed.

Delta Messages ID, Data, Column | Computes time difference between two messages on a single decoded
line.

Bus Load ID, Data, Column | Computes the load of selected messages on the bus (as a percent).

Message Bitrate ID, Data, Column | Computes the bitrate of selected messages within the decoded stream.

Number of Messages ID, Data, Column | Computes the total number of messages in the decoding that meet con-
ditions.
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Graphing Measurements

The Measure/Graph package include simplified methods for plotting measurement values as:

» Histogram - a bar chart of the number of data points that fall into statistically significant intervals or bins. Bar
height relates to the frequency at which data points fall into each interval/bin. Histogram is helpful to
understand the modality of a parameter and to debug excessive variation.

» Trend - a plot of the evolution of a parameter over time. The graph's vertical axis is the value of the parameter;
its horizontal axis is the order in which the values were acquired. Trending data can be accumulated over many
acquisitions. It is analogous to a chart recorder.

» Track - a time-correlated accumulation of values for a single acquisition. Tracks are time synchronous and
clear with each new acquisition. Track can be used to plot data values and compare them to a corresponding
analog signal, or to observe changes in timing. A parameter tracked over a long acquisition could provide
information about the modulation of the parameter.

To graph a measurement, just select the plot type from the Measure/Graph dialog when setting up the
measurement. All plots are Math functions that open along side the deocoding in a separate grid.

Measure/Graph Setup Dialog

Use the Measure/Graph Setup dialog to select the parameter to apply to the decoded waveform while
simultaneously graphing the results.

Vleasure/Graph Setup Eye Diagram Setup

D on Graph
* b ‘
) Trend

1 2 3 4 Bl
]I ] 1
Apply &

Ci
Number o onfigure

1. Select the Measurement to apply and the Destination parameter (Pn) to which to assign it.

2. The active decoder is preselected in Source 1, indicating the measurement will be applied to those decoder
results; change it if necessary. If the measurement requires it, also select an appropriate Source 2 (such as an
analog waveform for comparison).

3. Optionally:
» Touch Graph to select a plot type. Also select a Destination function (Fn) for the plot.

» Touch Apply & Configure to set a filter, gate or other qualifiers on the measurement.
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Filtering Measurements

Certain serial decode measurements can be filtered to give results for only rows with specified IDs, data patterns or
values in selected columns of data. When the measurement uses multiple sources, each source can have the same
or a different filter.

Main

1. After creating a measurement on the Measure/Graph Setup dialog, touch Apply & Configure. The touch
screen display will switch to the standard Measure setup dialogs for the parameter you selected.

2. From the Filter drop-down on the Main subdialog, choose the message elements on which to filter:
» Any displays results for any message (no filter).
ID restricts the measurement to messages with a specific ID value.
 |ID + Data restricts the measurement to messages with extracted data matching the filter.

¢ Col(umn) restricts the measurement to messages with matching values in the selected result table
column(s). It can be applied to timing measurements such as MsgtoMsg and MsgtoAnalog. It allows
you to use a column other than ID or Data as the start/end point for the measurement.

Tip: To make timing measurements on different parts of message frames within the same
decoding, choose the same Decode as measurement Source and Source2, Column filter both,
but choose a different column for Col1 and Col2. See the example below.

3. Set filter conditions on the right-hand subdialogs that appear next to the Pn dialogs.

ID Filter

Settings on this dialog may change depending on the protocol.

Main

Protocol

Format

Summary E STD(11)
Binary

Actions for P1

il \— Fﬂmfd Hex

Histogram

1. Onthe ID subdialog, choose to enter the ID in Binary or Hex(adecimal) format.
2. If the field appears, select the # Bits used to define the frame ID. (This will change the ID Value field length.)

3. Using the ID Condition and ID Value controls, create a condition statement that describes the IDs you want
included in the measurement. To set a range of values, also enter the ID Value To.

Tip: On the value entry pop-up: use the arrow keys to position the cursor; use Back to clear the
previous character (like Backspace); use Clear to clear all characters.
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ID + Data Filter

Measure ) 2 3 5 6 7 '8 Main D

Summary

Actions for P1

e

Histogram

0 Tip: For a Data only filter, leave the ID subdialog set to ID = ALL.

1. On the Data subdialog, choose to enter data in Binary or Hex(adecimal) format.

2. Create a Boolean Data Condition describing the Data Value(s) to include in the measurement. Use "X" as a
wild card ("Don't Care") in any position where the value doesn't matter.

3. Optionally, enter a Start Position within the data field byte to begin seeking the pattern, and the # Bits in the

data pattern. The remaining data fields positions will autofill with "X".

Note; For MsgtoMsg measurements, the data filter condition is entered twice: first for the Start
Message and then for the End Message. The measurement computes the time between finding a
match to each condition.

Column Filter

ET

Source 1

CAN FD Light

1. Onthe Measure/Graph Main subdialog, choose the Filter type Col(umn) for those sources where you want to
specify a column of data (i.e, message frame) as the start/end point for a timing measurement.

2. Onthe Col 1 and Col 2 subdialogs, choose the result table columns to Search for the Value.

ET Col1 Col 2 Holdoff Maore...

Column Filter

Note: In measurements where both sources are Column filtered, the measurement is made from the first
matching value in Col 1 to the first matching value in Col 2.
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Analog Filters

The measurements AnalogToMsg and MsgToAnalog allow you to use crossing level and slope to define the event in
the Analog waveform that is to be used as the reference for the measurement.

As with the decoder, Level may be set as a percentage of amplitude (default), or as an absolute voltage level by
changing Level Is to Absolute. You can also use Find Level to allow the oscilloscope to set the level to the mean Top-
Base amplitude.

A Slope and Hysteresis selection is also offered. The width of the Hysteresis band is specified in milli-divisions. See
Setting Level and Hysteresis for more information on using these controls.

Measure 2 2 23 4 25, ] 7 '8 [ET Analog Holdoff e ccept

Time from trigger g at a specified

E-'.IIT'IIT'\E\T'BI‘

Find Level
Actions for P1

el

Histogram

Digital to Analog Conversion

These serial data measurements enable you to take a subset of decoded data (such as sensor data payload) and
plot it as a graph. The track of the these measurements is, in effect, a Digital to Analog Converter (DAC) that can
display digitally-encoded sensor data as an analog waveform. They are particularly useful for symbolic and higher-
level decodings.

Note: Examples shown are taken from CAN decoders, but the functionality works the same for all protocols.

View Serial Encoded Data as Analog Waveform

This is an alternative set up method for Message to Value, which preselects for the Track graph. You can add filters
the same as for Message to Value by clicking Apply & Configure.

Message to Value

The MsgToValue measurement enables you to graph or test only a subset of a decoder result table. It is aimed at
protocols with addressed packets containing varying types of data, like CAN, LIN, MIL1553 and many others. With it,
you can filter the table by a particular ID to extract and convert decoded data values via a parameter that can be
used for other math or measurement processes, such as the Track function.

0 Tip: When SAE tests are turned on, the S column of the result table contains the numeric result (status bit)
of the tests. Any value 1 through 5 indicates an error. You can configure a parameter with MsgToValue
assigned to decoder column S, then set a Pass/Fail test on the occurrence of a particular status in that
parameter. See SENT Errors for status values.

For TDME users, MsgToValue can be assigned to a Source decoder and parameter right on the Measure/Graph
Setup dialog. However, MsgToValue requires several filter selections, so it is necessary to select Apply & Configure
to complete the set up on the Measure set up subdialogs.

continued
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1. Choose whether or not you wish to Filter by ID or accept Any packets, then select the Data Columnfrom which
to pass values.

Summary

Actions for P2

b

Histogram

2. If you are filtering by ID, enter the desired ID on the ID subdialog.

Main D Value

sgToValu
Summary
Actions for P1

el

Histogram

Summary

Actions for P1
e

Histogram

Follow these steps to define the values to extract:
a. SYMBOLIC users: touch Browse DBC/ARXML. Expand the symbol file, then click on the desired symbol
to filter on occurrences of that symbol.

Note: This button will not appear if your installation does not support symbolic decoding.

b. Under Data to Extract, begin by entering the Start position and the # Bits to extract.
c. Choose the Encoding type if the signal uses encoding, otherwise leave it Unsigned.

d. Under Conversion, enter the a. Coefficient and b. Term that satisfy the formula:
Value = Coefficient * Raw Value + Term.

e. Optionally, enter a Unit for the extracted decimal value.

Column to Value

Similar to MsgToValue, ColToValue acts as a special "pass thru" of one column of decoder table values via a
parameter configured with this measurement, allowing you to graph, run Pass/Fail tests or perform other
calculations on just these values by using the parameter as the source of other functions. It is very similar to using
Excel to graph a column of data.

ColToValue acts upon many columns in the table, not just Index or Data. There is no special setup other than the
column selection. It is therefore very useful for decodings of continuous data streams that are not "packetized" into
separately indexed table rows, or when you want to process values from columns other than Data.
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To use this measurement successfully, be sure there is an active decoding. If there is no data in the result table, the
Select Column field on the ColToValue subdialog shows "undef", and the selector is inactive. As long as there is data
in the table, you should see a selection of those columns populated by the decoder.

In the CAN FD example below, parameters P4 and P5 are both configured with the ColToValue measurement using
Source Decode. P4 is additionally histogrammed (F2), while P5 is tracked (F1).

[l File ¥ Vertical ++ Timebase [ Trigger @& Display # Cursors [ Measure [ Math [ Analysis = Utilites @ Support Decode... “.H‘""

227V s T ¥ IS 4%

‘ ‘\H‘ l‘
i e

264ms 464ms 6.64ms

264 ms 4.64ms 6.64ms 693.4 ps 7341 ps 7749 ps 8156 s 856.3 ps

P4:ColToVal(Dec... P5:ColToVal(Dec...
40 0e-12
26.95 738.1e-3
4.0 Oe-12
64.0 1.000000000000
2518 439.7e-3
42 42
2 2
Time Format 41D 4DE F£DF BRS £SI RTR DLC Data SBC CRC CL BitRate BR Data Status
854.62 us FD 0x200 0 1 MMM MMM Tt MT T MMM T T T T T MMM T T T T 1T 1111111111111 = 0x30f77 21 499907 1.99999e+6
1.19182ms FD Ext 0x009 1 1 48 4d 53 5f 72 75 6¢ 65 7a 21 dd ee ff 00 00 00 10 0x1c9c3 17 497733 1.99881e+6
1.37988ms FD 0x200 0 1 MMM T MM T T T MMt T MM T T MM T T MM 1T 1M1 111111111 42 0x30f77 21 499629 2.00000e+6
29 1.71710ms FD 0x002 0 il 12345678 3 0x84be 17 497852 500000 v
900 mV/div 200e-3/div 2.00 #/div 900 mV/div 12 Bits 1.00 ms/div Stop  -900 mV
1.3300 V ofst 1.00 ms/div 10.0/div 2.5MS 250 MS/s CAN FD
#

Serial Decode Decode Setup Measure/Graph Setup @ CLOSE

Source 1 Destination Graph Destination
Decodel P nﬂh: Histogram

L (.

Apply &

Col to Value Configure

After beginning to configure the parameter on the Measure/Graph Setup dialog, the Apply & Configure button opens
the Measure setup ColToValue subdialog, where you Select (the) Column whose values are extracted. Parameter P4
is confgured to pass the DLC column data, whereas P5 (not shown) passes the BRS column data. This is the data
set that appears in Measure table P4 and P5 and is represented by the F2 and F1 functions that graph the
parameters.

Measure P1 P2 P3 P4 P5 P6 P7 P8 P9 P10 P11 P12 ColToValue Gate Accept

Source1

oz Measure
Type Decode1 M- ColToValue

MM on

e |measureon

Select Column
waveforms Summary

DLC

B math on ColToVal(Decode1)
e parameters Actions for P4

LE

advanced il

web edit Histogram
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Eye Diagrams
Not supported on WaveSurfer and HDO4000 series oscilloscopes.

Eye diagrams are a key component of serial data analysis. They are used both quantitatively and qualitatively to
understand the quality of the signal communications path. Signal integrity effects such as intersymbol interference,
loss, crosstalk and EMI can be identified by viewing eye diagrams, such that the eye is typically viewed prior to
performing any further analysis.

The eye diagram shows all values a digital signal takes on during a single bit period. The bit period (also referred to
as unit interval, or Ul) is defined by the data clock, whether explicit or extrapolated depending on the protocol. Each
pixel in the eye takes on a color that indicates how frequently a signal has passed through the time and voltage
represented by that pixel.

The eye can be generated from all transitions in the acquisition or from a "filtered" set of transitions by using the
Apply to Zoom feature. With Apply to Zoom, only transitions related to the zoomed ( highlighted) table rows are
included in the eye diagram.

Note: Serial decode eye diagrams show the decoded signal as it has been configured for the result table.
They are not persistent, as are eye diagrams generated in some other serial data analysis software; the eye
will change from one acquisition to the next and when the result table is filtered.

Our recommended approach to using the eye diagram is to:
» Make single acquisitions with decoder and eye diagram enabled to test both are working correctly.

» Make a normal acquisition with Mask Testing and Stop On Failure enabled (if masks have been defined for the
protocol), or with a Pass/Fail test set on one of the eye parameters.

Eye Diagram Setup

Note: Examples shown are taken from CAN decoders, but the functionality works the same for all protocols.

Serial Decode D Setup Measure/Graph Setup Eye Diagram Setup Mask Failure Locator

Decode 1 CAN XL

2.000000 Mbi Arb\t{al\[nn

Decode 2 CAN FD m i !
1 Standard Custom
Decode 3 CAN FD Light

Eye Saturation

~ % \
Decode 4 C c CAN FD 500k4Mbps H-L

Create Eye Diagram
1. Open the Eye Diagram Setup dialog and select the Decode for which to create an eye diagram.
2. Under Eye, check Enable to display the eye diagram.

3. Enter the Bitrate of the section of the decoding to be diagrammed. This should match the Content selection in
protocols where there is an option.
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10.

Select the type of decoded Content (e.g., packet type) from which to draw the eye diagram. The eye will be
created solely from transitions of that type, without having to manually adjust the Bitrate. The Content
choices will vary by protocol.

Caution: Conflicts can occur if the Content type does not match the table selection when using Apply
to Zoom. Zoom only single rows and change Content to match the row zoomed.

Choose an Eye Hor(izontal) Unit of either Time or Ul. The eye diagram graticule is redrawn accordingly.

To diagram only the zoomed row(s) of the decode result table, check Apply to Zoom. Eye measurements will
also reflect only this zoomed section.

The Upsample factor increases the number of sample points used to compose the eye diagram. Increase
from 1 to a higher number (e.g. 5) to fill in gaps that can occur when the bit rate is a submultiple of the
sampling rate, or the acquisition does not sample a sufficiently large number of Uls.

To rescale the eye diagram to fit the entire grid, check Auto Scale.

Choose an Eye Style of either color-graded or analog persistence:

LY
With color-graded persistence , pixels are given a color based on the pixel's relative population and the
selected Eye Saturation. The color palette ranges from violet (lowest) to red (highest).

Analog persistence uses relative intensities of the same color.

Use the Eye Saturation slider to adjust the color grading or intensity. Slide to the left to reduce the threshold
required to reach saturation.

Eye Measurements

You can optionally choose to display the Eye Height and/or Eye Width measurement parameters. The read out will
appear in the first open slots of the Measure table, with markers drawn over the eye diagram.

Eye Mask Test

A mask test of the eye diagram is a quick way to verify basic signal integrity. Many standard eye masks have been
included for the protocols where masks have been defined. You can also upload custom masks.

1.

2.

w

Set up and display the eye, then under Mask, check Enable to turn on eye mask testing.

Select to use either a Standard or Custom mask, then Browse to and select your Mask File.

. Optionally, check:

» Mask Failure On to mark the parts of the eye diagram that "hit" the mask. Mask violations appear as red
circles where the eye diagram intersects the mask.

» Mask Hits to display the total number of mask violations on the Measure table.

To delve deeper into mask hits, check Failure Location and use the Mask Failure Locator feature.
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Mask Failure Locator

The Mask Failure Locator feature plots a sequence of just those bits that failed an eye mask test. It is essentially a
signal "error" waveform

When you select the Failure Location box from the Eye Diagram Setup dialog, the Mask Failure Locator dialog is
added to the screen, along with the Mask Failure waveform in a new grid. A list of those Uls (by number) that contain
failed bits is shown at the right of the Mask Failure Locator dialog in Eye Mask Failures, and the failed bits from that
Ul are marked on the eye diagram with yellow circles, so you can see exactly where on the eye the failure occurred.

In #U| Displayed, enter the number of bits (as a decimal) to display at once in the Mask Failure waveform.

Enter the maximum number of Uls to plot on the Mask Failure waveform in Max Failures. This helps to create a
manageable limit to the plot.

Stop On Failure stops acquisition whenever an eye mask failure occurs. This can help you to more closely examine
the eye and the Mask Failure waveform to ascertain when and where failures occurred.

[ File ¥ Vertical #* Tim e [ Trigger & Display C 3 e B Math | Ana XN Utilities @ Support 1o g Gesture U-rid-\°

59.2 ms 792 ms 992 ms

FD 0x110
0

TR TR T II I“ll'iff [T IR I'}Illn

11322 ms

C P2:frea(C1) MaskHit(Eve1l
value — 69
status a v
[CANFD il ~Format  ~ID ~IDE~FDF-BRS E Sl+RTR-DLG-Data +SBG CRC +CL ~BitRate  ~BR Data
1 -1.57 us FD 0x30a 10 §4 aaaaaaaaaadaaaa aaaaaaaaad. 41 Oxldbale 21 500161 9990

00 00 00 0O 00 00 00 00 0x42e0
FD 0x00a bf bf bf 4 01E
s FD Ext 0x20a ft ff ff ff ff ff fF fF fF fF ff fF fF fF fF fF fF 6 & F 500080

Z1  zoom(M1 CANFD Eyel I ! Timebase 0 nsf Trigger K400

1.00 V/div 1.00 V/div 1.00 V/div 4 i 50.0 ns/div Stop 0.0 mV

39.6 ps/div 10.0 ms/div 83 ns/div 3 s/d | 20kS 40 GS/s Edge Positive
619 # |

i
5

Serial Decode ecode Sef easure/Graph Setup Eye Diagram Setup Mask Failure Locator g CLOSE

) e Maslk Failures (Ul #)
Decode 1 CAN FD

Decode 2 1000Base-T1
Decode 3 1000Base-T1

Decode 4 1000Base-T1

CAN FD mask test with Failure Location on. Yellow markers indicate where the displayed Mask Failure bits are located.

If you select a Ul by number from the from the Eye Mask Failure list, the Mask Failure waveform shifts to display
those error bits from the selected Ul. Conversely, if you drag the Mask Failure waveform, the visible Ul is highlighted
in the list, and the yellow failure markers will shift according to the bits currently displayed.

Note: Mask Failure On marks all mask violation on the eye with red circles. Failure Location marks only
those violations related to the Ul currently selected/displayed by the Mask Failure plot.
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Appendix A: Automating the Decoder

As with all other oscilloscope settings, decoder features such as result table configuration and export can be
configured remotely using COM Automation.

Note: The examples shown here were taken from a CAN FD decoding, but all decoder result tables share the
same Automation structure.

Configuring the Decoder
The object path to the decoder Control Variables (CVARSs) is:

app.SerialDecode.Decoden

Where n is the decoder number, 1 to 4. All relevant decoder objects will be nested under this. Use the MAUI Browser
utility (installed on the oscilloscope desktop) to view the entire object hierarchy.

Accessing the Result Table

The decoder Result Table is a complex matrix with secondary tables nested within some of its cells. The table data
can be accessed using the Automation object:

app.SerialDecode.Decoden.out.Result.cellvalue(RowA, ColA)(RowB, ColB)
Where:

n=1t04

RowA:= 0to K (0=Row Index Number)

ColA:= 0 to L (0=Column Header)

RowB:= 0=MeasuredValue, 1=StartTime, 2=StopTime

ColB:=0to M

Complicating the matter of accessing the table is that there are two types of cell that may appear in the Result table,
Simple Cell and Table Cell, which are accessed in slightly different ways, and that some columns are always hidden
from view, yet they are still counted among the columns when querying.

Reading the Structure of the Result Table

In order to successfully access the data, it is necessary to first ascertain how many rows and columns are actually in
your decoder result table, and what cell type is used for the column of data you wish to read.

To do this, we have provided the script, ExampleTableSerialDecode.vbs, which by default installs into oscilloscope:
C:\LeCroy\XStream\Scripts\Automation\ExampleTableSerialDecode.vbs.

Tip: This script may also be used as a basis for your own remote control programs, or used as is to read
decoder table data.
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With the decoder table populated, run the script from the oscilloscope (or a PC if you have a remote connection to
the oscilloscope). The script will generate the comma-delimited file, ExampleTableSerialDecode.txt, which may be
imported into Excel or other spreadsheet software to show the table structure.

Result.Rows: 8
Result.Columns: 34

CANFD Time Format PRIO 1D SRC IDE FDF BRS ESI RTR DLC Data
1 -7.48E-03 FD 31;-7.48024976:0;-7.4522 1;-7.4502! 1;-7.4462 0;-7.44455189402753 6;-7.44405 174;-7.44205462545681E-03;-7.43805466420848E-03;143;-7.438054664 20848E-03;-7.43405452651836E-03;
2 -4.59E-03 FD 190;-4.5834578: 0;-4.5634 1;-4.56141 1;-4.5574 0;-4.55575366881187 B;—4.5552Ei 0;-4.55326066828695E-03;-4.54326025140856E-03;0;-4.54326025140856E-03;-4.54376023553057E-03;0;-4.
3 -4.48E-03 FD 614;-4.4741593:0;-4.4501 1;-4.448111;-4.4441 0;-4.44245573215831 6;-4.44155 0;-4.43596012906669E-03;-4.43546015204063E-03;0;-4.43546015204063E-03;-4.43046028360746E-03;0;-4.
4 -4.37E-03 FD 44;-4.37086003¢ 0;-4.3448 1;-4.342811;-4.3388 0;-4.33716034438709 8;-4.33666 0;-4.33466132067482E-03;-4.32966079442337E-03;0;-4.32366079442937E-03;-4.32516075451935E-03;0;-4.
5 -2.77E-05 Std 325;-2.5744779¢0;-1.7452 0;2.54715560793993E-07;2.27: 0;-3.74528 §;2.27402] 69;1.02543932013556E-05; 2.625487054 73 216E-05;80;2.62548705473216E-05;4.2273996 764758 2E-05;128;4
6 2.58E-03 FD 31;2.586421380 0;2.614411;2.61641 1;2.620410;2.62211966414495E 6;2.62261¢ 128;2.62461650529113E-03;2.62911836054307E-03;72;2.62911836054307E-03;2.63311895907048E-03;97;2
7 5.35e-03 FD 44;5.355213390 0;5.381211;5.38320 1;5.3872( 0;0.005388911407171 8;5.38540¢ 0;5.39141045889392E-03;5.39641115645398E-03;0;5.39641119645398E-03;5.40091119496943E-03;0;5.400¢

Example spreadsheet after importing ExampleTableSerialDecode.txt.

The first two rows of the imported file will show the total number of rows and columns in the table, in this example 8
rows and 34 columns. This indicates the range of your RowA and ColA keys.

The third row of the imported file will replicate the column headers of the Result Table (0), with individual records
(frames, messages, etc., depending on how you have "packetized" the decoding) appearing in subsequent rows (1-n).

Counting from 0O at the far left (Row Index Number), find the column of the data you wish to access. That will be the
ColA key in your script.

Note: Do not confuse the number/letter of the cells in the imported file with the rows/columns of the Result
Table.

Hidden columns (whether hidden by you or the software) must still be counted, so, in the example above, PRIO is
column 3, making ID column 4, and so forth. So, if you wished to access the ID of record 6, the first argument of your
query would be: (6,4)

Within each column, Simple Cells contain a single value that appears at the specified location in the table. In the
above example, columns 0 through 2 are Simple Cells. Simple Cell VBS access syntax is:

vbs? return=app.SerialDecode.Decode.out.Result.cellvalue(RowA,ColA)'

However, many cells of the Result Table are the Table Cell type, nested tables that may contain multiple "B" columns
and always three "B" rows that, when coupled with the column key, each return a different component of the
measurement: (0,ColB) = MeasuredValue, (1,ColB)= StartTime, (2,ColB) = StopTime. These cells can be identified by
the list of semi-colon delimited values within them. The first three values in the list are Col0, the second three values
are Col1, and so forth.

To access Table Cells, the (RowB,ColB) argument is sent in a second parenthesis, following the A "locators™:
vbs? 'return=app.SerialDecode.Decode1.out.Result.cellvalue(RowA,ColA)(RowB, ColB)'

Although the image above does now show it, the ID and IDE columns each contain a single-column, three-row
nested table. To read the values from such columns, you would add the argument (0,0) following your "locators":
(RowA,4),(0,0) and (RowA,6),(0,0) respectively.

Reading the Data column (RowA,12) is more complicated, because it contains a multi-column, three-row nested
table, as indicated by the longer list of values. To access the full Data column value for each record, all Co/Bs must
be called by your script.

For example, if these were your decoder results:
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ICANFD I ~Format  .ID +|DE~FDFBRS-E 51+ RTR. DLG- Data
74822 ms FD 0x01f 01 1 0 ae 8f a0 a3 00 06
-4 5915 ms 0x0be 1 0 ' 00 00 00 00 DO 00 00 0O
4 4762 ms 0x%266 1 0 00 00 00 00 00 00
43729 ms 0x02c 1 0 ' 00 00 00 00 DO 00 00 0O

0
0
0
-27.74 us 5 02145 0 45 50 80 00 00 00 00 0O

1
1
1
]

5.35321 ms ¢ 00 00 00 00 00 00 0O 0O

The following table shows example VBS queries you might add to a remote control program to read data from the
decoder result table.

Remote Queries Returned Value(s) What Is Read by Query
vbs? return=app.SerialDecode.Decode.out.Result.rows' 8 Number of table rows
(incl. header Row 0)
vbs? 'return=app.SerialDecode.Decode.out.Result.cellvalue(6,0)’ 6 Value in first 3 columns
vbs? return=app.SerialDecode.Decode.out.Result.cellvalue(6,1)’ 2.58442.. E-03 of Row 6, including:
vbs? return=app.SerialDecode.Decode1.out.Result.cellvalue(6,2)’ FD Index #in Row 6 Col 0

Time in Row 6 Col 1
Format in Row 6 Col 2

vbs? 'return=app.SerialDecode.Decode.out.Result.cellvalue(6,12)(0,0)' 128 Data value in ColBO of Row
6 Col 12

vbs? 'return=app.SerialDecode.DecodeT.out.Result.cellvalue(6,12)(1,0)' 2.62461...E-03 StartTime of Data in ColB0O
of Row 6 Col 12 (hidden)

vbs? 'return=app.SerialDecode.Decodel.out.Result.cellvalue(6,12)(2,0)' 2.62911..E-03 StopTime of Data in ColBO
of Row 6 Col 12

vbs? 'return=app.SerialDecode.Decodel.out.Result.cellvalue(6,12)(0,1)’ 72 Data value in ColB1 of Row
6 Col 12

vbs? 'return=app.SerialDecode.Decode.out.Result.cellvalue(6,12)(1,1)' 2.62911..E-03 StartTime of Data in ColB1

of Row 6 Col 12 (hidden)

Modifying the Result Table

The CVAR app.SerialDecode.Decoden.Decode.ColumnState contains a pipe-delimited list of all the table columns
and their current state (visible=on, hidden=off). For example:

app.SerialDecode.Decodel.Decode.ColumnState = "Idx=0n|Time=0n|Data=0n]|..."

If you wish to hide or display table columns, send the full string with the state changed from "on" to "off", or vice
versa, rather than remove any column from the list.
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Technical Support

Live Support

Registered users can contact their local Teledyne LeCroy service center at the number listed on our website.
You can also submit Technical Support requests via the website at:

teledynelecroy.com/support/techhelp

Resources

Teledyne LeCroy publishes a free Technical Library on its website. Manuals, tutorials, application notes, white
papers, and videos are available to help you get the most out of your Teledyne LeCroy products. Visit:

teledynelecroy.com/support/techlib

The Datasheet published on the product page contains the detailed product specifications.

Service Centers
For a complete list of offices by country, including our sales & distribution partners, visit:

teledynelecroy.com/support/contact

Teledyne LeCroy

700 Chestnut Ridge Road
Chestnut Ridge, NY, 10977, USA
teledynelecroy.com

Sales and Service:

Ph: 800-553-2769 / 845-425-2000
FAX: 845-578-5985
contact.corp@teledynelecroy.com

Support:
Ph: 800-553-2769

support@teledynelecroy.com
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